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Welcome to PaperPort
Welcome to the Nuance® PaperPort® Getting Started Guide. It is supplied as a PDF 
file, suitable for use with screen readers. If you print it to paper, we recommend 
double-sided printing with two pages per sheet.

PaperPort provides the easiest way to turn paper into organized digital documents 
that everybody in an office can quickly find and use. PaperPort works with 
scanners, multifunction printers, and networked digital copiers to turn paper 
documents into digital documents. It then helps you to manage them along with all 
other electronic documents in one convenient and easy-to-use filing system. 

PaperPort’s large, clear item thumbnails allow you to visually organize, retrieve and 
use your scanned documents, including Word files, spreadsheets, PDF files and 
even digital photos. PaperPort’s Scanner Enhancement Technology tools ensure 
that scanned documents will look great while the annotation tools let you add notes 
and highlights to any scanned image.

Accompanying programs
PaperPort 12 includes a PaperPort image printer, a ScanDirect application 
(described later), a Scanner Setup Wizard, an ImageViewer application (for viewing 
and working with page images in a window separate from PaperPort)  and PDF 
Viewer Plus (for viewing and working with PDF files). In PaperPort Professional 
12, the PDF Viewer Plus includes Nuance PDF Create, providing high-level 
support for PDF creation from a wide variety of source files.

Installing PaperPort 
You can install PaperPort from a CD or from the Web.  The installation program 
provides easy step-by-step instructions. Follow the guidance on each screen to 
install the software. Installation and un-installation require Administrator rights.
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PaperPort installation comprises three elements that are installed in a single process:

• PaperPort program (includes ImageViewer, Scan Direct and Wizard)

• PDF Viewer Plus (in PaperPort Professional this includes PDF Create.)

• PaperPort image printer. 

PDF Viewer Plus is not installed if the top-line Nuance product PDF Converter 
Professional is detected on the computer (version 5.3 or above) because it provides 
all the functionality of PDF Viewer Plus, and much more additionally.

Click Autorun, select an installation language, accept or change the program 
location. If PDF Viewer Plus/Create is to be installed, you have two checkmarks:

Set Nuance PDF as your default viewer for Windows and Internet Explorer

This sets PDF Viewer Plus as your system default PDF viewer. PDF files on the 
PaperPort desktop are by default opened in a Nuance PDF product. If you select 
this option, PDF files that are double-clicked anywhere on your system will open in 
PDF Viewer Plus.

Install all Nuance PDF button and menu application add-ins 

This places a Nuance PDF ribbon or toolbar in Microsoft Word, Excel, 
PowerPoint, Outlook and Internet and Windows Explorer and Corel WordPerfect, 
allowing PDF Create to make PDF files from the current document or mail 
attachment or web page. Go to Control Panel Add/Remove programs to later 
enable or disable these add-ins individually.

Autorun then starts the installer. It offers a Compete or a Custom installation. 
Choose Custom only if you want to add your own folders to the supplied PaperPort 
folders during installation. You can add folders later (see page 24). 

Activating PaperPort
Most versions of PaperPort 12 and the associated PDF Viewer Plus require 
activation. For activation and deactivation you need web access. You will be invited 
to activate the product at the end of installation. Choose from automatic or manual 
activation. The recommended choice is automatic; then PaperPort and the PDF 
Viewer (with PDF Create for the Professional product) are activated together. 
Provided your serial number is found at its storage location and has been correctly 
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entered, no user interaction is required and no personal information is transmitted. 
Manual activation requires interaction and the two programs must be activated 
separately.

If you do not activate the product at installation time, you will be invited to do this 
each time you invoke the program. PaperPort 12.0 and the PDF Viewer can be 
launched only five times without activation.

Registration
Registration enables you to take full advantage of Nuance® product support and to 
receive notifications of product updates.

When you finish installing PaperPort, you are prompted to register online. If you 
want to update your registration information, you can always go to the Nuance web 
site at http://www.nuance.com.

Learning PaperPort
This guide introduces you to PaperPort and shows you how PaperPort can help you 
manage your information. Additional sources of information to help you learn how 
to use PaperPort include a comprehensive Help system, the How-to-Guides, 
Release Notes, and the Nuance web site. Access these from the Help ribbon.

Using this Guide
This guide is written with the assumption that you know how to work in the 
Microsoft® Windows® environment. Please refer to your Windows documentation 
if you have questions about how to use dialog boxes, menu commands, scroll bars, 
drag and drop functionality, shortcut menus, and so on.

Using Help 
The PaperPort Help includes detailed information on features, settings, and 
procedures. Help is available from the PaperPort Help ribbon.
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Additional technical support, including technical notes, software updates, product 
information and product support issues and more is available also from the 
PaperPort Help ribbon. 

PDF Viewer Plus, and also PDF Converter Professional, have their own help 
systems that include guidance on PDF creation.

Using release notes
PaperPort Release Notes provide important information about this release of the 
program. This document is included on the installation CD, from the PaperPort 
Help ribbon, and as a sample document on the PaperPort desktop.

Technical Support
Nuance offers both complimentary and fee-based technical support options 
designed to meet your individual needs. Our services offer person-to-person 
telephone and e-mail technical support. We also offer self-service, 24-hour access 
to our Knowledge Base. 

Visit http://www.nuance.com for information about your support policy, local 
support contacts, and product updates. Before contacting Nuance, be sure to read 
the user documentation and review the Release Notes.

Minimum System Requirements
A computer with an Intel® Pentium® or higher processor

Microsoft Windows XP 32-bit with SP3 or above, Windows Vista 32-bit and 64-bit 
with SP2 or above, Windows 7 (32- and 64-bit versions)

Microsoft Internet Explorer 6.0 or above  

512 MB of memory (RAM), 1 GB recommended

500 MB of free hard disk space for application files plus 20 MB working space 
during installation

SVGA monitor with 256 colors, but preferably 16-bit color (called Medium Color 
in XP and Vista) and at least 800 x 600 pixel resolution

Windows-compatible pointing device
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CD-ROM drive for installation, or suitable web access for download 

Web connection (with IE 6 or above) for activation and web updates

 

What’s new in PaperPort 12?
PaperPort 12 includes a number of valuable new features to help you manage your 
documents. 

Improved PDF performance

PDF files can be opened more speedily and displayed in PDF Viewer Plus, a newly 
developed Nuance PDF handling application that is fully compatible with Adobe 
Acrobat. PDF Viewer Plus opens files much faster than the general-purpose 
ImageViewer, reducing memory requirements and permitting smaller file sizes. The 
new viewer optimizes the rendering resolution for each element on the page 
yielding a cleaner display and optimum print resolution. PDF Viewer Plus has its 
own Help system.

Enhanced support for PDF files

PDF Viewer Plus provides a wide range of new PDF features including improved 
annotations and dynamic or transparent stamps. Images within a PDF document 
processed by PDF Viewer Plus can be sent to the ImageViewer to be enhanced 
using SET tools, with the modified image returned to the PDF. 

Fill and e-mail PDF forms and create new ones, either from scratch or by using an 
updated FormTyper integrated into PDF Viewer Plus to instantly make any static 
form fillable. 

It uses Logical Form RecognitionTM technology to detect the form elements and 
also allows their properties to be managed better than ever before. 

Performance and speed will be enhanced if your computer’s processor, memory, 
and available disk space exceed minimum requirements. This is especially true 
when handling very large color image and PDF files. 
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Searchable PDF files are now available through Scanner Profiles, through a right 
click ‘Save As’ operation on the PaperPort Desktop, or directly in PDF Viewer Plus.  
This makes the content of your scanned paper documents or image files accessible 
to search engines such as Windows Desktop Search or Google.

Tab-and-ribbon User Interface

PaperPort 12 is now easier to use because all the program features are presented on 
a set of tabbed ribbon style toolbars with controls placed in functional groups.  
We've also added the new ‘Scan Now’ button so you can scan with one click 
without having to change to the scanner settings view.  A customizable Quick 
Access Toolbar appears above the ribbon toolbars so you can put your most 
frequently used features in one easy-to-find place. Accelerator keys allow command 
activation from the keyboard; press the Alt key to see the accelerator values. 
Background,  panel and ribbon colors can be customized.

More accurate OCR

OCR (Optical Character Recognition) scanning accuracy has been significantly 
increased; this is reflected in greater success when searching the content of 
Searchable PDF file archives. Language settings can now be applied to Optical 
Character Recognition to provide even greater accuracy in all supported languages.

Digital camera input

The Send To bar options for text applications have been updated to include a 
PaperPort OCR option for digital camera correction.  It is now possible to take a 
picture of a document and accurately convert it into a text document. This is done 
by applying special 3D-deskewing algorithms that flatten page images and correct 
distortions to increase the accuracy of the resulting text document.

Making PaperPort more reliable

Sometimes PDF files may become corrupted so that they can no longer be opened. 
In these cases PaperPort may not be able to generate a desktop thumbnail and this 
may prevent PaperPort from launching properly.  A new utility program  
CheckPPFolders.exe is supplied in the PaperPort program folder, along with a 
short help file. Run this program to identify and remove any corrupt files so that 
PaperPort will work properly.
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The following advanced features are available only in PaperPort 
Professional 12:

Folder Management

You can now automatically create multiple folders by importing a list of folder 
names from a text file.  This option is available when you right-click on any folder. 
See the Help topic ‘About PaperPort folders’ for the required syntax.

New features in PDF Viewer Plus and PDF Create Assistant

You can create industry-standard text-based PDF documents from any application 
directly with a right-click through the Windows or PaperPort Desktops (up to PDF 
version 1.7), using the PDF Create Assistant or by printing directly from any 
application with the printer driver called ‘ScanSoft PDF Create!’  Additionally you 
can create PDF packages, batch create PDF files and much more using the PDF 
Create Assistant. A table in the Help topic ‘About creating PDF files’ summarizes 
which starting places, inputs, options and targets are available.

Support for SharePoint

PaperPort Professional 12 is able to communicate with the Microsoft SharePoint 
Services 2003, SharePoint Portal 2003, SharePoint Services 2007 and SharePoint 
Server 2007 document management systems: get files from there, process them as 
desired, and then save the results by sending the output files back through the Send 
To bar. ScanDirect supports scanning to PDF with the results directed to 
SharePoint.

PaperPort is also supplied in Special Editions to selected scanner manufacturers and other 
resellers. The feature set in these editions may vary, in line with each vendor’s requirements.
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Getting to Know PaperPort
This section introduces you to the different parts of PaperPort. Refer to 
the PaperPort Help for detailed information about all these topics.

The PaperPort desktop
The PaperPort desktop appears with the Folders pane when you first start the 
program. It displays the documents in the chosen folder as thumbnails and 
provides tools to manage them. PaperPort offers all the tools necessary to 
organize, find, and use documents and images. Choose Options from the 
Desktop ribbon and go to the Desktop panel to choose a color scheme for 
the desktop and its elements.

The Function pane can present:
• Folders
• Scan Settings 
• Thumbnails
• All-in-One Search
• Properties 

Image item 
thumbnail

Text item 
thumbnail

Access to 
other pages 
in this multi-
page item

Desktop 
showing item 
thumbnails

Send To bar

Ribbons with command buttons

Function Pane 
showing folders
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The PaperPort Ribbon
PaperPort 12 and ImageViewer have a 
modernized tab and ribbon interface. 
The main elements are:

1.  The PaperPort button
2.  Quick Access Toolbar (see page 20)
3.  Tab

4.  Ribbon associated with the tab
5.  Group inside the ribbon
6.  Button within the group

7.  A button drop-down list.  

PaperPort items
The documents and photographs you acquire in PaperPort are called items. 
There are two types of items: image items and text items.

• Image items are scanned documents, photographs, drawings and 
other digital items in an image format, such as PDF Image, PDF 
Searchable, JPEG, TIFF, or PaperPort Image (.max) files. They can be 
scanned, copied or imported into the PaperPort desktop. 

• Text items are documents that contain editable text, such as Word 
(.doc), HTML, and Excel files, and are created by word processing and 
other text-based applications. Normal PDF files are considered to be 
text items. 

Image items when double-clicked open by default in Image View that offers 
many image-handling tools, including the SET tools. Go to Options > 
Desktop to change this behavior. You can choose ImageViewer; this offers 
the same functionality as Image View, but in a separate window so you can 
still view the PaperPort desktop as you edit the chosen item. This is specially 
useful in a dual-screen environment. You can also choose to open the item in 
the application associated with the file type.
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You can use any flavor of PDF file: PDF Image, PDF Searchable, and PDF 
Formatted Text and Graphics (PDF Normal) with PaperPort. PDF files by 
default open in PDF Viewer Plus or (if available) PDF Converter 
Professional. These Nuance programs are optimized for handling, annotating 
and editing PDF files. Go to Options > Desktop to change this behavior. 
You can open PDF Image or PDF Searchable files in ImageViewer in order 
to use the SET tools to improve the quality of PDF-image only items.

You can quickly send an item to another program without leaving the 
PaperPort program. Just drag an item onto the link icon in the Send To bar at 
the bottom of the desktop. PaperPort supports a wide variety of programs 
including word processing, spreadsheet, fax, Internet e-mail, graphics, optical 
character recognition (OCR), and online services programs. 
PaperPort includes a My PaperPort Documents folder with a subfolder 
Samples, containing items to demonstrate some of the types of items you 
can keep on the PaperPort desktop. 
You can also use PaperPort to view non-PaperPort items that reside on your 
computer. Simply copy or move the document file or photo into a PaperPort 
folder.

The Folders pane
The Folders pane presents a hierarchical view of your 
PaperPort folders, similar to the view you see in Windows 
Explorer. Use the Folder Tools to access its commands 
quickly.

PaperPort installs a PaperPort folder named My 
PaperPort Documents into your My Documents folder. 
If you are using a multi-user system, each user has their 
own My PaperPort Documents folder.

The My PaperPort Documents folder contains several subfolders whose 
names –such as Articles, Business Cards, Photographs, and Receipts – 
illustrate the different ways you can organize your items in PaperPort. 

The Samples folder contains sample documents and photographs to help you 
get started using PaperPort. 
PaperPort Getting Started Guide           14



When you have acquired your own PaperPort items, you do not have to use 
the My PaperPort Document folder to store them. You can add other local 
and network folders to PaperPort’s Folder View. You can also delete the My 
PaperPort Documents folder, but your PaperPort structure must contain at 
least one folder.

PaperPort item thumbnails
There are two kinds of thumbnails in PaperPort: item and 
page thumbnails. Each item thumbnail is a small, graphic 
representation of your document or photo. Page 
thumbnails show pages of image items and PDF files in the 
Page Thumbnails pane both on your PaperPort desktop 
and in the ImageViewer.

One quick way to locate your PaperPort items is to visually browse through 
the item thumbnails on your PaperPort desktop. Thumbnails show you 
what’s in a document without having to open it. Thumbnails also give you the 
ability to scroll through the pages of a document without opening it.
PaperPort shows large, clear thumbnails of all your documents and photos, 
including:

• Scanned pages and photos

• Photos from your digital camera

• Image files in formats such as BMP, TIFF, JPEG, GIF, and MAX

• Microsoft Word, PowerPoint®, Excel®, Word PerfectTM , and other 
documents created in popular software programs

• PDF documents

• PDF Image items

• HTML documents 

To show or hide the Folders pane, click the Folders button on the Desktop 
ribbon. With the desktop split, Folders panes can be displayed for each 
Workspace.
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Each item thumbnail appears with an icon that identifies the program in 
which it was created or is currently associated. This makes it easy and 
convenient to quickly see and find all the different types of items on your 
computer.

Click on a thumbnail to see image attributes: 

A small  icon indicates that the Read-only attribute is set for that item. 

A small  icon indicates that the image has annotations. 

Multi-page image items show  to let you scroll through the pages even 

with the Page Thumbnails pane closed.
Before you can work with an item, you must first select its thumbnail on the 
PaperPort desktop. A red border appears around an item to indicate that it is 
selected. Multiple selections are possible. While working with item 
thumbnails, you can: 

• Drag a thumbnail to reposition it on the PaperPort desktop.

• Drag a thumbnail to a folder to move the item to that folder.

• Drag a thumbnail to another open Workspace to move the item to 
that open folder.

• Double-click a thumbnail to view the item.

• Press the Ctrl key and double-click a thumbnail to open the item in its 
source program.

• Right-click a thumbnail to display the item’s shortcut menu.

• Drag a thumbnail to the Send To bar to send a copy of the item to 
another program.

Using item thumbnails on the PaperPort desktop, you can also easily combine 
individual PaperPort Image items or PDF Image items into multi-page items. 
This feature is useful as an organizational tool if you are using a scanner that 
can only scan a page as a separate item. 
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PaperPort page thumbnails
The Page Thumbnails pane on the PaperPort desktop and in ImageViewer 
displays thumbnails for multi-page image items. Select a multi-page item, then 
click the Thumbnail button on the Desktop ribbon. Page-level operations 
can be done quickly without having to open the files. The first three items 
listed below are available for all image files. The remainder are available for 
PDF files (both on the PaperPort desktop and in ImageViewer or PDF 
Viewer Plus) and MAX files (PaperPort desktop only). You can:

• Enlarge or reduce thumbnail size.

• Copy and move selected pages to a Workspace as separate PDF files.

• Copy and move pages between documents open in different panes.

• Copy, paste, cut, delete and reorder pages.

• Insert new pages at a certain location in the document.

• Append new pages at the end.

Two-part desktop
When you first start PaperPort Professional 12, the desktop 
appears split into two Workspaces – top and bottom. This 

layout gives you a better oversight necessary to organize and combine your 
documents more effectively even in a cross-folder fashion. Right-click the 
active Workspace or use the Change View button to change the way of 
viewing. If you work with documents containing multiple pages, you can use 
the corresponding function pane to view page thumbnails without having to 
open the given document. You can also use these desktop areas to view your 
folders, or the properties of the selected item. To remove the desktop split, 
open the Desktop menu, and uncheck the Split Desktop menu item or click 
the Split Desktop icon.

The Page Thumbnail view of a secure PDF is only available by supplying its 
password.
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You can also bookmark the Workspaces of your choice by using the 
Bookmark Workspace command from the Desktop menu. To manage 
them, use the Organize Bookmarks command. Getting to a frequently used 
Workspace is just a mouseclick away, since they are all displayed in the same 
list.

Function pane 
showing page 
thumbnails 

Desktop split

Function pane 
showing 
folders

Inactive 
Workspace

Active 
Workspace

Send To bar
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The Image View window
To view an image item in the Image View window, double-click its thumbnail 
in Desktop view, or choose Open with Image View on the Desktop ribbon 
or from its shortcut menu. By default PDF files appear in PDF Viewer Plus, 
not in Image View.

The Image View window allows you to take a closer look at your items and to 
touch up and annotate them. You can also enlarge or reduce the view for easy 
reading. Use the SET tools to enhance the current page image. Use the Page 
Thumbnails pane to edit your document at page level. 

SET tools on the 
Page ribbon

Select 
Area 
button

Page Thumbnails Pane displays 
one thumbnail for each page in 
the document

Return to Desktop button, 
by default on the Quick 
Access Toolbar 
(also on the View ribbon)

Current page 
displayed in 
large size, 
ready for 
enhancement 
or annotating
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Customizable Quick Access Toolbar
PaperPort’s buttons are placed on different ribbons according to their 
functionality. You can place frequently used buttons on the Quick Access 
Toolbar in PaperPort and also in ImageViewer. Right-click within the ribbons 
area and choose Customize Quick Access Toolbar.

PDF Viewer Plus
PDF files on the PaperPort desktop when double-clicked appear by default in 
the new PDF Viewer Plus. You can drag other files onto the PDF Viewer 
Plus icon in the Send To bar (see page 40) to have a copy converted to PDF 
and opened in the PDF Viewer. The first page appears in the main screen 
area; a navigator panel on the left shows page thumbnails or form controls 
and a comments panel can be displayed along the bottom of the screen. An 
organizer panel on the right offers stamps. The PDF annotation tools are 
described on page 31. If an image-only PDF enters the PDF Viewer, the 
program may offer to make it searchable. If not, choose Make Searchable 
PDF from the Tools menu.

Active PDF forms can be filled in directly in PDF Viewer Plus. Static forms, 
for instance ones scanned to PaperPort, can be turned into fillable forms by 
using FormTyper, as described on page 44.
PDF files opened from the PaperPort desktop return there when you finish 
editing or annotating them with all the updates included.

Set toolbar 
button order

Buttons currently visible 

Choose the ribbon 
whose buttons you 
want to add

Add/remove buttons More available buttons
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Acquiring Items
There are many ways to bring images and documents into PaperPort so that 
you can use PaperPort’s viewing, editing, annotation, indexing, OCR, and file 
management tools. For example, you can:

• Scan photos, pages, and other images on a scanning device.

• Add folders to PaperPort that already contain images and documents.

• Import files from other programs on your computer.

• Print documents from other programs to the PaperPort desktop.

• Drag or cut-and-paste images and documents from Windows 
Explorer, or other programs to the PaperPort desktop.

• Acquire photos from a digital camera.

• Bring files into PaperPort Professional 12 using DesktopDelivery.

• Capture snapshots of web pages, using a supplied but separate utility 
that runs on Windows XP.

Scan to the PaperPort desktop

PaperPort is designed to work with TWAIN- and WIA-
compatible scanners. 
Click the Scan Settings button to display the Scan or Get 
Photo pane. Choose a scan profile. Profiles are optimized 
for typical scanning tasks.

Then choose between using the native interface of the 
scanner or utilizing the new Scanner Settings pane of 
PaperPort for best scanning results. To use the interface of 
the scanner driver, mark the checkbox Display scanner 
dialog box. Leaving it empty will put the scanned item 
onto the active Workspace. 

Turn on the Capture Assistant to add subject, author and keywords to items 
and (in PaperPort Professional) to view and control scanning progress.
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When the scan is complete, you will see your item on the PaperPort desktop.

PaperPort makes it easy to scan pages as separate items or as a multi-page 
item. To scan and collate two-sided pages on your ADF scanner, flip the 
pages when prompted, click Scan Other Side, and PaperPort will 
automatically scan and collate the pages in the correct order.

You can also use your scanner device buttons to scan directly into PaperPort. 
Open the Windows system Control Panel, choose Scanners and Cameras, 
choose an event in the Events tab, and assign PaperPort to it.

Set up your scanner with PaperPort
Before using PaperPort for scanning, your scanner should 
be installed with its own scanner driver software and tested 
for correct functionality. Scanner driver software is not 
included with PaperPort.

Properly installed and correctly functioning scanners are 
immediately available in PaperPort by clicking the Select 
button, and choosing one in the Available Scanners 
dialog. 
If you are not satisfied for your scan results, you can run 
the PaperPort Scanner Setup Wizard from the Start menu, 
under the program group PaperPort 12.0.

Using Scan Profiles
PaperPort comes with scan profiles optimized for typical scanning tasks. 
Choose Black and White, Grayscale or Color Document, Color Photograph 
or Color Searchable PDF Document. 

If your scanner does not use a TWAIN or WIA device driver, use the program that 
came with your scanner to scan items. Then, copy or move the scanned items to 
PaperPort. Refer to the PaperPort Help for more information about scanning.

You can also use a high-speed, networked scanner to scan items to a networked 
folder and then add the folder to PaperPort. Use DesktopDelivery (available in 
PaperPort Professional 12) to monitor folders for incoming scanned images.
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Scan profile panels have the following tabs:

• Profile: displays the currently used scan profile.

• SET: define what enhancements you would like to run automatically.

• Output: set file format and automatically suffixed file names.

• Scan: adjust scan settings: mode, resolution, size, orientation, filter 
color, brightness and contrast

In PaperPort Professional 12, you can also add new profiles, or remove 
existing ones. This edition of the program contains an extra scan profile: 
Color PDF-MRC High Compression. MRC is a technology that lets you 
make much smaller PDF files.

Print to PaperPort

To bring items in from other programs, print them to the PaperPort desktop 
as PDF Image, PDF Searchable or PaperPort Image (.max) items. The default 
is PDF Image; go to Desktop > Options > Item to change it. This lets you 
quickly import spreadsheets, pictures, database files, word processing files, 
and other files into PaperPort as items on the PaperPort desktop. This works 
through the File menu (or equivalent) in the source application; choose Print 
to PaperPort or choose Print, then choose PaperPort Image Printer. 
With PaperPort Professional, you can use PDF Create add-in buttons in 
Office applications to make a PDF from the current document or attachment 
in the Formatted Text & Graphics (PDF Normal) format. Do this also by 
choosing Print and selecting the printer named ScanSoft PDF Create!.

Choose Print in your web browser to create print-formatted views of web 
pages. The printer PaperPort Image Printer gives you MAX, PDF Image or 
PDF Searchable files, the ScanSoft Printer gives you Normal PDF.

In all cases, PaperPort is launched if not running and the PDF file is placed 
on the current desktop.

Capture web pages

You can use Web Capture to capture web pages on the Internet as PaperPort 
Image items or PDF Image items on your PaperPort desktop. These items 
function as convenient pointers to your favorite web sites.
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Once you capture a web page, you can view it, archive it, go to the actual web 
page on the Internet (MAX items only), or index the content of captured web 
pages. This program is installed along with PaperPort, but is not integrated 
into it. Go to the program folder and run PPwebcapture.exe. It functions 
only on the Windows XP operating system. A short help file is available at 
the same location.

Add PaperPort folders

PaperPort provides an easy-to-use filing system for 
organizing your items and sharing them with others. In 
the Folders pane, you can:

•  Add existing folders on your computer to the 
    Folders pane. 

•  Create new folders, mapped network drives 
    and folders on external attached devices. 

Initially, the Folders pane shows a set of folders designed to help you get 
started using PaperPort. You can move or delete these folders whenever you 
prefer. If you choose a custom installation, you can add your own folders at 
that time.
Any time later, you can add folders already on your computer to the Folders 
pane, including network folders and folders on external devices attached to 
your computer. Documents within these folders are then available for use 
within PaperPort.

Refer to the PaperPort Help for more information about adding and using 
PaperPort folders.

Use the Print to PaperPort feature to create print-formatted views of web pages, 
which can also be added to the All-in-One Search index for searching by text 
content.

Use Folder Notes to assign the same file information to all PDF or MAX files 
arriving in a folder of your choice through scanning or DesktopDelivery. 
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Use DesktopDelivery
DesktopDelivery (PaperPort Professional 12 only) monitors 

network or local folders for incoming files of specified types (PDF, TIFF, 
JPEG and MAX). It can also monitor e-mail folders for attachments. It 
imports these files to specified PaperPort DesktopDelivery folders (i.e. 
PaperPort folders designated to receive files from a monitored folder outside 
PaperPort). Right-click on any PaperPort folder and select DesktopDelivery 
from the shortcut menu. 

You can auto-add item properties to PDF and MAX files entering the 
selected DesktopDelivery folder. Refer to the PaperPort How-to-Guides or 
Help for details.

Import pictures from your camera

To bring digital photos on the PaperPort desktop, first plug your camera in. If 
your device is displayed as a drive you can start acquiring your files. If your 
camera does not support this kind of operation, and its driver is installed 
properly, its TWAIN or WIA interface will display enabling you to import 
images from it.

Do not edit the images on your camera in place – not all editing produces the 
desired result first time. Instead, bring your files into PaperPort and use the SET 
tools to enhance them.

Monitored e-mail inbox folder

Monitored folder
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Touching Up Images
When you display an image item in the Image View 

window, PaperPort provides several tools you can use 
to adjust or improve your image. 
For example, you can straighten a scanned page, 
lighten an underexposed photograph that is too dark, 
adjust the color in a color picture, remove “dirt spots” 
from a document page, clear shadows and spots from 
page edges, or sharpen fuzzy pictures. In addition, you 

can rotate an item, remove stray dots, enhance lines, remove red eye, and crop 
part of an image. 

Some SET Tools are primarily designed for photo, or image enhancement, 
while others (shaded) help you prepare items containing text for Optical 
Character Recognition (OCR).

Scanner Enhancement Technology tools
Select Area Use the Select Area tool to select part of an image 

you want to cut, copy, or delete using the 
commands on the Page ribbon or in the shortcut 
menu. Use it also to select part of an image before 
cropping or using the Remove Red Eye tool.

Rotate an 
image

Click the Rotate Right tool to rotate the selected 
item 90 degrees to the right.

Straighten 
an image

Sometimes a document is crooked when scanned. 
When this occurs, you can use the Straighten and 
Auto-Straighten tools to adjust it. Straightening 
lines of text in an image file will yield better OCR 
results.

Auto-
enhance 
an image

The Auto-Enhance feature adjusts the brightness 
and contrast, color, and tint of an image. PaperPort 
analyzes the image and tries to correct whatever is 
wrong with it.
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Enhance 
an image 

 You can manually adjust your image using the 
Enhance tool. It lets you change brightness, 
contrast, color and tint values and choose the best 
result from nine candidates, as shown on page 29.

Sharpen 
an image 

Select the Sharpen tool to adjust the sharpness of 
a blurry picture or blur a sharp image for special 
effect.

Remove 
red eye
 

The Remove Red Eye tool helps you to remove 
the red-eye effect from a selected part of a picture. 
Red Eye may occur when photographing people or 
animals in low light or with a flash.

Remove 
part of 
an image
 

When you want to save or work with only part of a 
page or image, you can crop the image or you can 
erase the part that you do not want to use. 
Use the Selection tool to define the part you want to 
keep and then use the Crop tool to remove the 
remainder. Select the Eraser tool to erase the area of 
the image that you draw over with the pointer.

Remove 
stray dots 

Scanned images sometimes include stray dots or 
“speckles”. The Remove Stray Dots tool 
automatically finds and removes such “dirt” from a 
page. Use it for better OCR results. Works on black-
and-white images.

Improve 
lines 

The Improve Lines tool (for black-and-white 
images) darkens lines and connects broken lines in a 
table or form to appear darker and straighter. The 
use of this tool will render better recognition results. 

Erase 
edges

Use this tool to clear shadows and spots from page 
edges to improve OCR performance.

Set white 
point

Click this tool, then click on a light color in the 
image that will become the white point. See below. 
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Set black 
point

Click this tool, then click on a dark color in the 
image that will become the black point. The colors 
chosen for the new white and black points are 
displayed on the Status bar.

Apply 
current 
black and 
white points

Click this tool to apply the new black and white 
points to the current image. If the result is not 
acceptable, undo your changes and pick new values.

Changing the black and white points
You can do this to improve image quality by removing the very dark and 
overexposed areas. All colors lighter than your chosen new white point will 
become white. All colors darker than your chosen new black point are set 
to black. A typical use for this is to remove a shaded gray background in a 
document you want to OCR. Select one of the darker gray pixels from the 
background and apply it as the white point. Then the background will 
become white. Changing black and white points for a color photo will 
typically increase its contrast, but may also change color values.

You can apply new black and white points to individual images, as 
described. You can also apply them as an auto-enhancement to all new 
pages scanned with a given scan profile.
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Enhancing Images Manually
Choose Enhance from the Page ribbon in Image View to receive nine 
candidate variants of your picture. Adjust brighness and contrast, color, or 
tint, then double-click the desired image. It is placed in the center and 
becomes the new original. The first original remains and can be reset.

Edit multiple images
The ability to process items as a group is often referred to as batch 
processing. PaperPort provides batch processing features so that you can 
quickly enhance, modify, or rotate multiple image items in a single operation.
Select one or more image items on the desktop, and then, on the Item ribbon, 
choose the desired command. See the Help for more information.

Click to finish 
enhancing

Slider for less 
or more

Original image 
(with reset)

Current selection

Choose to modify 
Brightness & Contrast
Color
Tint
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Annotating Pages
PaperPort includes a collection of annotation tools that allow you to mark up 
scanned documents with information you would like to keep with that 
document. PDF files are best annotated in the supplied Nuance PDF 
product. PaperPort Image (.max) files and all other image items must be 
annotated in Image View or ImageViewer, but remember that you can drag 
any of these files onto the Nuance PDF product icon on the Send To bar to 
have them converted to PDF Image or PDF Searchable, ready to be 
annotated or otherwise edited.
In PDF and PaperPort Image (.max) files, annotations are editable, meaning 
that you can reposition, change, remove them, or edit textual content 
whenever you want. On other types of image items, such as JPEG and 
Windows Bitmap files, annotations become a permanent part of the image 
when you save the item. For item types that cannot accept annotations, 
PaperPort automatically disables the annotation tools. 

Using PaperPort’s annotation tools, you can add notes and text, highlight text, 
draw lines and arrows, or stamp a picture onto an image item.
It is easy to send a document with annotations to people without PaperPort 
by using the PDF Image or PDF Searchable format. The recipient only has to 
double click on the e-mail attachment they receive from you and they will see 
the document in the system default PDF viewer – annotations intact.

Annotation tools
You can select an annotation tool from the Annotation ribbon whenever you 
display an image item in the Image View window. Use commands in the 
Annotation Settings group to change properties for future annotations 
created with that tool. This does not affect existing annotations. To turn off 
any annotation tool, click a different one – the Select Annotation tool is 
usually the best for this. See a detailed list of these tools in Help. 

We detail here the annotation tools available in PDF Viewer Plus for use with 
PDF files.
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Use the following commands in PDF Viewer Plus:

Hand 

Select this tool and click in an annotation to move, 
cut, copy, or resize it on the page. Double-click on a 
note or text box to edit its text. Right-click on a 
selected annotation to change its status or properties.

Note

Want to give yourself a reminder? Select the Note 
tool and add a resizable note much like a sticky note 
that you write on and then stick on paper 
documents. You can shrink the note to an icon. 
Right-click to access note properties. Double-click to 
re-open the note.

Text Box

Adding a text label to your images is simple with the 
Text tool. Select this tool to enter text whose 
properties you can set in Edit > Preferences > 
Comment.

Highlight
Use the Highlighter tool to highlight selected text 
on the page or in a text box, just as you might use a 
highlighting pen on paper.

Pencil
The Pencil tool lets you draw freehand lines  on the 
page.

Line 
Select Line tool to draw straight lines; right-click and 
choose properties to make arrows and further 
format the line. 

Stamp 
The Stamp tool lets you paste supplied stamps or 
bitmapped images of your choice on the page, much 
like using a rubber stamp.  
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Protecting Items
In PaperPort Professional 12, you can adjust the security level 
of your PDF files (supported up to format 1.7). When you 
create a new PDF from existing ones (for example, by copying 
a thumbnail of a page onto a Workspace) its security settings 
will be the same as those of the original one. Newly created 
PDF files will be generated according to the default PDF 
security settings in PaperPort, as specified on the Item ribbon.

There are two types of passwords in the program. The open password 
restricts document accessibility: you can only open it by supplying the 
password when prompted. The permissions password allows users to define 
how the document may be used. If it is not specified, further use of the file is 
possible without any restrictions. 

Filing Items
A key to organizing items in PaperPort is filing items in appropriate folders. 
You can drag and drop items from one folder to another or from the 
PaperPort desktop into any folder you want. You can specify search criteria to 
help you find your items later. Moving and copying items between folders is 
also possible in split view across Workspaces. The name of each item appears 
below the thumbnail in thumbnail view. In a multi-page item, the name 
appears below the individual page names.

Using the Folder Manager dialog box, you can add, 
remove, move, and rename PaperPort folders. You 
can change the color of a folder icon to one that 
helps you organize your items. You may also add, 
remove, move, and rename any folder in Windows 

Explorer that is viewed with the PaperPort folder structure. These changes 
will be automatically reflected in PaperPort.

In the Folders pane, you can drag and drop, copy or move subfolders and 
their content to other subfolders or PaperPort folders, create or delete 
subfolders; or add Folder Notes. Sharing and Security, and DesktopDelivery 
adjustments can also be directly made for each folder shortcut menu. 
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The Back button makes it easy to step through the ordered history 
of folders you recently visited one by one – functioning similarly to 
Internet Explorer – enhancing quick backward navigation for both 
Workspaces independently of each other.

You can add notes to folders that are relevant to their content. A 
customer name, telephone number, date of birth, project ID, 
e-mail address are typical examples.

When scanning or using DesktopDelivery, this information can be 
automatically added to all PDF or MAX files entering this folder, so it is 
easier to search for them with the PaperPort All-in-One Search or other 
search utilities.

Folder Notes are automatically added only if you checkmark ‘Automatically 
add keywords from Folder Notes’ in the Output panel of the Scan Settings 
dialog box or (in PaperPort Professional for DesktopDelivery) in the Folder 
Properties dialog box.

In PaperPort Professional, you can quickly import a set of folders plus any 
content  by listing them in a plain text file with precisely this structure:

*** PaperPort ***
Foldername1
Foldername2
Foldername2/subfoldername2a
Foldername2/subfoldername2b
Foldername3
...etc.

Right-click in the Folders pane and choose Import Folder Structure to select 
the text file.
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Add search criteria to items

You can assign item properties to PaperPort Image items and PDF files, and 
then use the properties as search criteria to find items in PaperPort. 

PaperPort also allows you to assign the same keywords to multiple items at 
the same time, providing a powerful tool for organizing and locating similar 
documents and images. 
Select multiple items on the PaperPort desktop, then choose Properties 
from the shortcut menu; words entered under Subject, Author and 
Keywords will be applied to all selected items.
Another way to assign the same item properties to all PDF or MAX files 
arriving in a folder of your choice through scanning or DesktopDelivery is to 
use Folder Notes. Enter words under Subject, Author and Keywords. These 
words are applied only if you checkmark ‘Automatically add keywords from 
Folder Notes’ in the Output panel of the Scan Settings dialog box or (in 
PaperPort Professional) in the Folder Properties dialog box for 
DeskopDelivery.
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Finding Items

PaperPort provides features to help you find your PaperPort items. You can 
quickly find an item by visually browsing through thumbnails on your 
PaperPort desktop. 

When you have many folders and items, PaperPort provides more powerful 
capabilities with All-in-One Search. 
All-in-One Search provides many options for specifying where and what to 
look for when finding an item, including indexed text content. This 
information is referred to as search criteria. 
You can look for items by:

• Item properties (File search)

• Text content (Index search)

Find items by their properties
You can search for any type of item by its item name.

You can also search for PDF and PaperPort Image (.max) files by item 
properties, such as keywords and subject information. 
When you search by item properties, turn off the ’Use All-in-One Search 
index’ checkmark, then specify criteria as follows: 

• Name – item name (not necessarily that of the file). 

• Author – as defined under Item properties. 

• Keywords – as defined under Item properties. 

• Comments – as defined under ’Subject’ under Item Properties. 

• Annotations – Notes or text labels added to PDF or MAX files.

• URL – The link texts of captured web pages.

The Author, Keywords, Comments and URL are available for PDF or 
MAX files only.
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Find words in an item
To search for words within an item, you need to add the item to the 
All-in-One Search index and select Use All-in-One index. When you search 
using the index, you can find items that have been indexed by their 
properties, or text content, or both.

Specify search limits:
• all files in current folder but not its sub-folders
• current folder plus sub-folders
• all PaperPort folders and sub-folders.

Define search precision:
• Exact match finds words and common endings: search look finds looks, 

looked, etc.
• Approximate match finds as above and more: search look might find 

lock or luck.

When the search is complete, results are displayed – each as one row of a 
table. Select one and click the View Text button to see your search phrase 
occurrences in their context. Click the Copy Text button to extract text from 
the file and place it onto the Clipboard. Right-click a result file and choose 
‘Open’ to launch the document in its associated application. ‘Open 
Containing Folder’ switches to the file’s folder with the file selected.
To filter search results using file information, turn on the relevant check-
boxes under Name, author, keywords and specify search text here as well.

Add items to the All-in-One Search index
The All-in-One Search index uses PaperPort’s OCR software to extract and 
copy textual content from your items, and creates a database of the words or 
phrases in those items, much like the index of a book. Item properties, such 
as name and author, are also added to the index. Although creating an index 
is time consuming, searching for items in the index may be much faster than 
searching file by file.
Using PaperPort Options available from the PaperPort button, you can 
specify whether you want All-in-One Search to run automatically each time 
you add a new item or modify an existing item. You can also set how long 
PaperPort should wait before starting the update process.
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If you prefer, you can manually update the All-in-One Search index for all 
items, a single item, or all items in one or more folders. It is good practice to 
update the All-in-One Search index on a regular basis to shorten the length of 
time required to complete the process. 

Use the All-in-One Search pane
Use the All-in-One Search pane to enter search criteria and 
select options for finding your PaperPort items.

A file search is based on item properties only. You enter 
the item properties in the Name, author, keywords box.
An index search references PaperPort’s All-in-One Search 
index to find item properties or actual text contained 
within an item. You enter the item properties in the Name, 
author, keywords box and the text content in the 
Containing indexed text box.

To do an index search without a file search, enter a string in the Containing 
indexed text edit box and clear all six file search checkmarks.

To do a file search without an index search, turn off the Use All-in-One index 
checkmark and enter a string in the Name, author, keywords edit box, select 
as many of the six file search checkmarks as desired.

To do a file and index search on a single search string, turn on Use All-in-
One Index, enter the string in the Containing indexed text edit box, make 
sure the Name, author, keywords edit box is empty and turn on as many file 
search checkmarks as desired. The search returns a list of all items that match 
the search string, either in file contents or file information.

To do a combined file and index search, turn on Use All-in-One Index, enter 
a string in the Containing indexed text edit box, enter a string (same or 
different) in the Name, author, keywords edit box and turn on as many file 
search checkmarks as desired. The search returns a list of all items that 
contain the specified string or strings in both the file contents and the file 
information. In other words, you are likely to find few occurrences.

Use the Index Manager in PaperPort Professional 12 to create and schedule 
indexing tasks on a regular basis. For quick access to your regular indexing 
processes, launch the Index Manager directly from the All-in-One Search pane.
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Use PDF Searchable Image
In addition to using PaperPort’s proprietary search and indexing 
capabilities, you can also create  PDF Searchable Image files 
that can be indexed and searched outside of PaperPort. PDF 
Searchable is a flavor of PDF; it contains a bitmapped image of a 

document or graphic with textual content stored as hidden text. This format 
maintains an identical appearance to the original document and enables other 
programs, such as Nuance PDF Converter Professional, Windows Desktop 
Search or Google to search the contents of the file. 
You can create files in PDF Searchable Image format as follows:

• Open an item and choose Save As from its shortcut menu. Choose 
PDF Searchable Image as its file type.

• Scan an item using the profile ‘Color Searchable PDF document’.

• Import an image-only PDF into PDF Viewer Plus or PDF Converter 
Professional. It may offer to make a searchable copy; if not select 
Make Searchable PDF from the Tools menu.

• Print an image to the PaperPort desktop. By default it becomes an 
Image PDF. Go to Desktop > Options > Item to specify Searchable 
PDF as your preference.

 

Schedule indexing tasks

The Index Manager is a PaperPort 
Professional 12 application 
designed to create, modify and 
schedule indexing tasks for a given 
local or network folder. Indexed 
files can afterwards be searched 
with the All-in-One Search. 
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For new tasks you can set which folder to browse (local or network) with 
subfolders included or excluded, set timing and recurrence (duration, pattern 
and range), activate and deactivate a task, pause its completion, or skip a task 
occurrence. In the program settings dialog box, you can specify how and 
when the Index Manager should stop.

Sharing Files
PaperPort provides many tools to make it easy for you to share files, images, 
and documents with friends, colleagues, and business associates. 
These tools are built into the program and are readily available on different 
ribbons for quick access whenever you need them.

To help you share your items with others, PaperPort makes it easy to:

With PaperPort, it is simple to set up a 
shared folder on a server or a PC that 
can act as a central repository for all 
important office documents. Each 
PaperPort client can connect to that 
folder and use PaperPort’s document 
management features and paper 
handling tools to find and use 
documents instantly.

E-mail items to others, simply by dragging the items to your 
favorite e-mail program on the PaperPort Send To bar.

Scan or convert items to the PDF format, the ever-popular
file-sharing format considered by many as the industry
standard for document distribution.

Access shared folders located on your local or wide area 
network, by adding the folders to your PaperPort Folder 
pane. 

Access Sharing and Security settings directly from the folder 
shortcut menu.  
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In addition, you can convert items to popular output formats for shared use 
in numerous other programs. To obtain a list of all supported program links, 
visit PaperPort at the Nuance web site at www.nuance.com. 

Sending Items to Other Programs
Drag and drop functionality makes opening your files in your favorite 
programs a snap. Simply choose the file you want and drop it onto the 
program icon on the Send To bar at the bottom of the PaperPort desktop.

Common office tasks like e-mailing and faxing are now faster than ever. The 
Send To bar makes using scanned documents in other applications easier by 
automatically translating the document into a form that the receiving 
application can understand. 
For example, you can drop a scanned image of a letter onto the Microsoft 
Word link on the PaperPort Send To bar, and PaperPort will recognize that 
the application you are attempting to open needs a text file rather than an 
image file. PaperPort will run OCR for you, and send editable text to Word 
rather than a static image file. 

PaperPort supports a wide variety of programs including word processing, 
spreadsheet, fax, Internet e-mail, graphics, optical character recognition 
(OCR), and online services programs. The program link on the Send To bar 
does any necessary conversion and may provide options for sending the item.

OmniPage OP Workflows PDF ConverterMicrosoft Outlook®

SharePoint
FormTyperPDF Viewer Plus
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Use OmniPage with PaperPort

If PaperPort exists on a computer with OmniPage, its OCR services become 
available and amplify the power of PaperPort. You can choose an OCR 
program by right clicking on a text application's PaperPort link, selecting 
Send To Options and then selecting OmniPage as the OCR package, instead 
of the always available PaperPort OCR.

With OmniPage you can:

• Instantly convert paper into usable Microsoft Office documents. 

• Turn PDF files into editable documents while retaining their layout. 

• Automatically process images from network MFPs and scanners. 

• Scan and convert documents into XML, PDF, TIFF and more. 

• Share documents using e-mail, Web, XML and e-Books.

• Use OmniPage workflows for instant but effective control
   over document conversions.

Customize the Send To bar
You can change the way program icons appear on the Send To bar in a 
number of ways. Specifically, you can add programs, and remove or rearrange 
program icons. Refer to the PaperPort Help for details.
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Adjust Send To options

 

 

If you have the professional version 
of OmniPage 14 or above on your 
system, use the Send To options for 
the OmniPage Workflows link to 
choose a workflow.

You can tune Send To options to 
specify how you want to use a 
certain program on the Send To bar. 
For example, you can specify the file 
format in which PaperPort will save 
an item.

To e-mail an item, simply drag and 
drop the item to your e-mail program 
on the Send To bar. Use the e-mail 
link options to specify the file format 
of the attachments and other options.
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Converting Items 
Using PaperPort, you can convert scanned documents and text items to 
image formats, and convert images back to text. 

Convert items to image formats
You can convert scanned documents and text items to image formats.
The Save As command allows you to save image items to any of a variety of 
standard image formats including PDF, JPEG, and TIFF, as well as the native 
PaperPort Image format (.max). 

 You can convert text items and image items to PaperPort Image items (.max) 
using the Duplicate as PaperPort Image command. The Duplicate as 
PDF Item command allows you to convert text items to PDF Image items. 
In PaperPort Professional 12, you can also convert text items such as Word 
documents, to PDF Formatted Text & Graphics format using PDF Create.
By selecting more than one item, you can convert multiple items to a new 
format at the same time. Refer to Help for details.

Assembling documents
You can assemble documents by combining them.  The files to be selected 
need to be in a single folder and selected in the order you want them in the 
stack. Click the arrow next to Combine Items and choose one of the 
available combinations:  

• Combine into PDF Stack: Each original page becomes one PDF 
page with no resizing.

• Combine into Multi-item PDF Pages, Resize to fit: This resizes 
the contributing items and always places four original pages onto a 
single PDF page.

• Combine into Multi-item PDF Pages, Maintain original sizes: 
This places as many original pages onto each PDF page as it can.

• Combine into Thumbnail PDF Page: This creates thumbnails of all 
item pages and fits as many as possible on a PDF page.
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Convert images to text
You can convert scanned documents to text by a simple drag and drop of the 
thumbnail to your word processor program. PaperPort automatically 
processes your scanned document using PaperPort’s OCR software, launches 
your word processing program, and loads the scanned text into a document 
ready for editing.

PaperPort also allows you to copy text from part of an image item for use in a 
text editing, word processing, or spreadsheet program.

The OCR software processes the text and copies it to the Windows 
Clipboard. Open the program in which you want to insert the text, and use 
Paste to paste the text in a file.

Filling Out Scanned Forms
FormTyperTM is a PaperPort program that enables you to fill in 
static forms, such as insurance forms, registration cards, and 
medical forms, that you scan to the PaperPort desktop.

You simply drag a form from 
the PaperPort desktop to the 
FormTyper program on the 
Send To bar. The form is 
converted to PDF if necessary 
and opened in your Nuance 
PDF product. FormTyper 
automatically analyzes the form, 
recognizes the blank areas in 
which data can be entered, and 
creates blank fields for the data. 
So that you can easily see where 
to enter data, FormTyper 

The original items remain in their original file types.

Combining usually takes more time than stacking because of PDF generation.

PaperPort Professional can additionally combine text items. To convert a text item, 
the application that created it must be available on your system.
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underlines each field in color. FormTyper can detect edit boxes and 
checkmarks.

Now, you can quickly type and tab to each field. You can also quickly 
reposition fields, insert new fields, and remove fields as necessary. After you 
enter data and complete the form, save the form to the PaperPort desktop so 
that you can print or e-mail the form in its entirety with its completed data.

If you have a pre-printed form, use the Print Only Fields tool to print your 
responses directly onto the form.

Creating PDF Documents
Nuance® PDF Create 5 lets you create PDF files from one or 
more source documents. The PDF files will be viewable, 
printable, searchable and editable.

How to Start PDF Creation
You can start PDF creation from different locations:

• from the Start menu through the Create Assistant

• from Windows Explorer or from your desktop using a shortcut menu

• from Microsoft Word, Excel, PowerPoint, Outlook or Internet 
Explorer using a toolbar or the PDF Create menu items or the 
Nuance PDF ribbon.

The Help topic ‘About creating PDF files’ details all the possible starting 
points for PDF creation and the available choices. 

PDF Flavors
PDF (Portable Document Format) files are often classified into 
three different types, commonly called flavors:

• PDF Image 
• PDF Searchable Image 
• PDF Formatted Text & Graphics (PDF Normal) 
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You can create one or more of these PDF flavors, depending upon your 
version of PaperPort software. Refer to the PaperPort Help for additional 
details. 

This table lists which features are available for creating each type of PDF in 
PaperPort 12 and PaperPort Professional 12: 

Web Capture must be run outside PaperPort. See page 23.
Duplicate item transmits the PDF flavor of the original to the copy.
Duplicate as PDF accepts non-PDF files as input. 

How to Get Help
Nuance PDF Create has a comprehensive HTML Help system. Access it 
through the Help system in PDF Viewer Plus or PDF or through the PDF 
Create menu in Microsoft Word, Excel or PowerPoint.
Press F1 to open Help at the topic describing the currently open panel.

Format PaperPort 12 
PaperPort 
Professional 12

PDF Image Scan or Get Photo
Print to PaperPort
Save As
(Web Capture)

Scan or Get Photo
Print to PaperPort
Save As
(Web Capture)
Duplicate Item

PDF Searchable Image Scan or Get Photo
Print to PaperPort
Save As
(Web Capture)

Scan or Get Photo
Print to PaperPort
Save As
(Web Capture)
Duplicate Item

PDF Formatted Text 
& Graphics

Scan or Get Photo Scan or Get Photo
Print to PaperPort
Duplicate Item
Duplicate as PDF
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Using ScanDirect
ScanDirectTM is a PaperPort program that enables you to scan 
items and send them directly to PaperPort or other programs on 
your computer without first running PaperPort.

ScanDirect runs as a separate program from the Windows Start Menu and 
displays the ScanDirect bar.

Using ScanDirect, you can scan an item and immediately send it to either:

• A program on the ScanDirect Send To bar – Icons on the ScanDirect 
bar represent the programs that are linked to PaperPort and to 
ScanDirect. To scan and then send an item to a certain program, click 
the program icon, and then scan the item. ScanDirect will 
automatically start that program when the scan is complete.

• The PaperPort desktop – To scan and then work with the item in 
PaperPort, click the PaperPort icon, and then scan the item. When the 
scan is complete, PaperPort starts and displays the item in PaperPort. 
You can then use all of PaperPort's features on the item.

When ScanDirect is used to scan to other programs it always works through 
the scanner’s own user interface; the scan profiles in PaperPort are not used.
When ScanDirect is used to scan items to the PaperPort desktop, the output 
is determined by the output setting for the previous scan: if it created an 
image item, the current scan will also do this, and if it created a text-type 
document (such as DOC, XLS, WPD, TXT or CSV) the current scan will 
create a PDF Image, which you can make searchable, as already described.

In PaperPort Professional, you can scan items directly to Microsoft 
SharePoint.

Scan to PaperPort 
desktop

Scan

Click for options Single or multiple pages

ScanDirect bar with icons for 
all scanning targets

Scroll right for more icons
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Uninstalling PaperPort 
For a full uninstallation, three PaperPort components should be removed, 
one after the other, in any order. The components are PaperPort 12, 
PaperPort Image Printer and PDF Viewer Plus. Removing only the image 
printer and/or the PDF Viewer will cause PaperPort to function incorrectly.

1. Select Add/Remove Programs from the Control Panel.
2. Select Nuance PaperPort 12.0.
3. Click Remove to uninstall the program.
4. Repeat this for the remaining components.
5. A computer re-start is needed to complete the removal.

A de-activation step is performed at the start of un-installation, allowing you 
to reinstall the program later without re-activation problems. De-activation 
and re-activation require web access.

PaperPort is protected by the following US patents and foreign counterparts: 
6,262,732; 5,077,807; 5,235,651; 5,261,009; 5,278,918; 5,278,920; 5,347,595; 
5,381,489; 5,436,983; 5,657,397; 5,778,092; 5,862,259; 6,038,342 and 6,047,251.
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